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• Computer monitor is positioned out of direct sunlight and at the correct
height.

• Environment is dust-free as dust can affect the monitor or central processing
unit of a computer.

• Cables are secured so no-one trips over them.
• Blinds and window coverings are used to reduce glare and heat at your

workstation.
• Temperatures don’t exceed 26°C and humidity is between 40 and 60 per cent.

Use ergonomic practices in the workplace
The aim of ergonomics is to reduce the risk of 
accidents, injury and ill health by applying safe work 
practices. Ergonomics is about creating comfortable 
working conditions by adapting workstations, tools 
and equipment to an individual worker’s needs. It 
also improves performance and productivity in the 
workplace. Ergonomics covers all aspects of working, 
from physical stresses such as sitting at a workstation 
all day to environmental factors such as noise, air-
conditioning and lighting.

Set up your workstation
A workstation includes a computer, screen, keyboard, mouse, desk and chair. How 
your workstation is designed can affect your health and wellbeing. Several physical 
problems can result from poor workstation design; for example, lower back strain 
may result from sitting  in a chair that does not support your back. Below are some 
guidelines for setting up your workstation to be ergonomically efficient.

Chair

Adjust your chair height so that your feet are flat on the floor, your 
thighs are horizontal and your lower legs are vertical to the floor.
Adjust the backrest by raising it to the maximum height and 
then lower it until it fits the curve of your lower back. If this is not 
comfortable, lower it another couple of centimetres. Continue this 
until a comfortable position is found. The backrest should support 
your lower back.
The backrest may also be adjusted backwards and forwards. 
When seated in your usual working position, move the backrest 
until it exerts a gentle pressure on your lower back. Make sure 
there is at least two centimetres of space between the front of the 
seat and the back of your knees. Armrests should be positioned so 
that they do not interfere with carrying out your tasks.
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Screen

Once you have adjusted your chair and desk, you can position 
your screen. Adjust it so that the top of the screen is level with or 
slightly lower than your eyes. If you can’t adjust the screen to the 
correct height, place the screen on a platform.
The screen should be at least 50 centimetres or an arm’s 
length away from your seated position to minimise radiation 
exposure; however, you should always adjust the position of the 
screen to suit you. It is best to position the screen so that you 
can clearly read the text without leaning forward, twisting your 
neck, or looking too far upwards. Also take surrounding factors 
into consideration, such as reflection, glare and shadow, when 
positioning your screen.

Workstation features
The features of an ergonomic workstation are highlighted in the diagram below. 
Some features of the workstation may vary depending on the type of computer 
work being performed. Graphic work may require the use of a pen tool, and 
multiple monitors are commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125 
degrees to the horizontal. 

Centre of screen Minimise screen reflection and glare by using an anti-glare filter.

Bottom of screen Place a document holder beneath or beside the screen at the 
same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

continued …
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Purpose
What is your electronic presentation about? You may have been asked to present 
information on a specific topic, or you may have decided to present something 
that you believe will benefit your colleagues. Whatever your purpose, make sure 
you fully understand what your presentation is about. 
You should be aware of the intended message; that is, 
what you want your audience to know. Your ability to 
explain clearly with words, text and graphics determines 
how clearly your message comes across. Start by writing 
a precise statement of the purpose of your presentation; 
for example, ‘I have to explain new health and safety 
regulations to my colleagues’.

Storyboards

Title
Topics of 

discussion

Topic 1 
Bullet 
Bullet 
etc.

Conclusions 
Bullet 
Bullet 
etc.

It is often helpful to create a storyboard to help you understand the purpose of 
your presentation. A storyboard is basically an outline of the major points. It 
should give a general idea of where text, pictures or charts will go and the order 
in which you will talk about them. You can quickly sketch a storyboard by hand 
on paper. Identify items that need to be presented earlier or later in the final 
presentation. Look for the most logical flow of understanding, or the best impact 
on the audience and their retention of the information you are presenting – 
rearranging the flow of your work if necessary.

Audience
If you take time to get to know your audience, the electronic presentation you 
develop will be more successful. Find out who your audience is. Simple questions 
will help; for example:
• Is it an internal or an external client?
• Does the group all come from the same unit/site or do the same job?
• What will they need to do after they have seen the presentation; for example,

will they need to practise a task or skill as part of your planning?
• Are there any people with ability or cultural issues that should be considered

when delivering the message?
• If known, what sort of presentations worked best for the group previously?
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Practice task 2
Read the case study, then answer the questions that follow.

Case study

Kate works as an office administrator in a large organisation. Her manager asked her to 
prepare an electronic presentation for external clients to explain upcoming projects. The 
clients were to view the presentation at a board meeting.
Kate assumed the clients already knew a lot about this topic and focused instead on the 
financial details of each project, including forecasted profits. She also used information 
that had not been confirmed by management and should not have been included. To 
present this information, Kate decided to set up a computer in the boardroom. The 
clients were to look at this individually when they had time.
On the day of the board meeting, Kate found out the clients had no prior knowledge of 
the future projects and wanted a broad overview. She also discovered that most of the 
clients didn’t know how to run the presentation themselves.

1. What should Kate have confirmed before producing the presentation?

2. What are the consequences of Kate’s poor planning?

3. What content would have been more suitable for Kate’s audience?

4. What method of presentation would have been more suitable?

5. Why do you have to understand the purpose, audience and method of presentation before
designing an electronic presentation?
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3 Digital pointer or annotation pen

When presenting information you might want to draw attention to an 
important point within a single screen. A hand-held digital pointer can do this. 
You can shine it on the display screen to emphasise a certain area. 
PowerPoint and a variety of other computer and tablet applications are now 
providing freehand annotation tools that allow the presenter to write on each 
presentation slide during the presentation. This can add or draw attention to 
existing information. Some tablet based applications can also make provision 
for the audience to annotate presentations as a mechanism of audience 
engagement.

4 Sound equipment and visual monitors

Audio speakers are often required even in smaller rooms, particularly if your 
presentation has a video clip or uses sound effects. Sometimes in a large 
venue it is necessary to install a background screen or extra screens around 
the room so that all participants can see a visual display clearly (without 
straining) by looking towards a stage area.

5 Network/Internet access

To illustrate certain points you can provide a hyperlink to an interactive 
presentation for participants’ use. This may require you to arrange (with your 
information technology department) for special access to data and logon 
privileges, and to be sure you are not breaching any privacy issues regarding 
data that will be displayed. 
Further to this, there is a wide variety of presentation technology which 
requires either cabled, Wi-Fi or mobile broadband networks to operate. The 
use of wireless technology is now common for transmitting all features of 
presentations including text, imagery, video and audio components.

6 Microphone/lapel microphone

A lapel microphone can be used for the speaker if they are not using a lectern 
and standing in one place while they present information. You may also 
consider the use of a hand-held microphone to help the audience participate 
fully. Assistants can be organised to minimise delays and avoid reducing the 
impact of the session.
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The use of resource conservation technique to prevent wastage should be a 
consideration in the workplace. Most organisations require staff to follow 
resource-saving procedures such as turning off lights in unused rooms and 
recycling paper. You need to be aware of any conservation efforts made by your 
organisation.

Organise your work
Having a well-planned workstation and comfortable surroundings is pointless if 
you don’t organise your work in a way that prevents discomfort or pain. Make sure 
you plan your daily tasks so that you aren’t doing repetitive work for long periods 
of time. Make sure you take rest breaks and exercise regularly.

Positive work organisation includes:
• a mixture of repetitive and other activities
• rest periods
• exercise breaks.

Vary your activities
Your work role may involve several different tasks. Some tasks may be repetitive, 
such as typing up reports or entering data. If you are able to vary the tasks you 
carry out each day, this will help prevent repetitive actions that cause stress to 
your body. For example, if you have to enter a lot of data, break up the repetitive 
nature of the task by discussing a project with a fellow worker, collecting some 
research from the internet or doing another constructive workplace task you are 
responsible for. Workflow should be designed to reduce the repetitive tasks given 
to particular people.

Take rest periods
All employers need to provide rest periods for employees. Rest periods include 
tea breaks and lunch breaks. During the working day everyone needs to sit down, 
breathe easily, relax and take time to think about something other than work.

Have exercise breaks
When working with a computer, you should have short breaks 
at regular intervals to combat stress and prevent pain and 
discomfort. As discussed previously, using computers for too 
long without breaks has been associated with back and neck 
pain, headaches, migraines and eyestrain.

v1
32

3

1D	 Use conservation techniques



24  © Aspire Training & Consulting

BSBITU302
Create electronic presentations

Resource conservation
Here are some tips for practising conservation.

Resource conservation tips

•• Use the power-save function on printers when they are not in
use.

•• Print and copy on both sides of the page, where possible.
•• Use recycled paper (paper used on one side) in the

photocopier and printer for rough drafts.
•• Use recycled paper for telephone messages.
•• Place a recycling bin near the photocopier.

Practice task 4
Look at the following statements and decide whether they are true or false.
1. Screen savers save energy.

2. Turning off computers crashes the hard drive.

3. Refilled toner or ink cartridges leak everywhere and make an incredible mess.

4. Putting computers into sleep mode when they are inactive saves energy.

5. Printing and filing all documents in hard copy does not put a high demand on resource
consumption.
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The electronic presentation you prepare may need resources such as 
transparencies, an overhead projector or a data projector. You may also have 
to prepare slides, notes or handouts. These may need to be designed to specific 
organisational style requirements; for example, using the corporate logo and 
colours.

You will use a software application to develop an electronic presentation. This 
means understanding the functions of the software and how you can best use its 
features for visual impact and emphasis. When designing a presentation, you need 
to work within designated time lines to ensure the work is ready when it is needed; 
for example, to meet a client’s requirements or be ready for a conference deadline. 

The operating system used in this unit is Microsoft Windows 7, and the software 
used is PowerPoint 2013.
In this topic you will learn how to:
2A	 Understand organisational style requirements
2B	 Use software functions
2C	 Balance presentation features
2D	 Use advanced software features
2E	 Work to a time line
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Example: introduction slide style
The following example shows the information required by an organisation for an introductory 
slide.

Body Style Inc.
S h a p i n g  y o u r  f u t u r e

A Healthy Future

John Lucas
Managing Director

4 June 2015

Company logo

Date

Title of 
presentation

Name and title of 
presenter

Example: presentation slide
The following example shows the information required by an organisation for a presentation 
slide.

Seminar: A healthy future

Overview
• What is a healthy lifestyle?

• Strategies for planning your future

• Success stories

Heading

Text

Body Style Inc.
S h a p i n g  y o u r  f u t u r e

Avoid distractions
If your electronic presentation is too busy, it can distract your audience from 
the content. Try to keep the presentation clear and concise and easy to view and 
listen to. 

If the content of your presentation is ‘heavy going’ for your audience, it can help to 
break it up with the occasional light-hearted slide, such as a cartoon relevant to the 
subject being delivered, a photograph or an amusing quote.



38  © Aspire Training & Consulting

BSBITU302
Create electronic presentations

Importing

Allows you to import information from other applications such as 
Word or Excel, as well as images or graphics.

Handout Master

Allows you to create handouts to go with your presentation.

Colour schemes 

A selection of background colours that you can apply to your 
presentation.

Templates

Templates contain colour schemes and text formatting to design a 
presentation with a particular look. You can alter the colours and 
text formats chosen within the template itself to customise these.

Hyperlinks

Allows you to create a link in the presentation to a place within 
that same presentation, or to another software file (for example, 
Word) or website.

Plan your presentation
As previously discussed, you need to plan your presentation before you begin. This 
means working out the purpose, audience and presentation method.

Then you need to prepare the content of your presentation. The best way to do 
this is to create a storyboard to help you map out the information you are going to 
present. 
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Note: The PowerPoint Help menu has a search feature, so you may type in your 
questions to find relevant topics and assistance.

Apply a layout by using the standard layouts that are built into PowerPoint 2013. If 
you want to customise your layout, see Layout in the help menu. 

1. Go to the File tab, and then click Save As. Choose where you want to save
the file.

2. In the File name box, type a file name, or do nothing to accept the suggested
file name.

3. In the Save as type drop-down menu, click PowerPoint Template, and then
click Save.

Background styles
Background styles are background fill variations from different combinations of 
theme colours and background intensities in the current document theme. Theme 
colours, theme fonts, and theme effects make up a theme background. A theme 
may be applied to a file as a single selection.

Click on the relevant slide to add a background style to your presentation. To select 
multiple slides, click the first slide and then press and hold Ctrl while you click the 
other slides. 

1. On the Design tab, in the Variants group, click the arrow, the drop-down
menu for Colors, Fonts, Effects and Background Styles will appear. Go down to
Background Styles.

2. Right-click the background style you want, and then do one of the following:
• To apply the background style to the selected slides, click Apply to Selected

Slides.

• To apply the background style to all of the slides in your presentation, click
Apply to All Slides.
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Create handouts and speaker notes
PowerPoint also allows you to create audience 
handouts and presenter speaker notes that 
can be viewed, edited or printed along with a 
presentation. Handouts are basically thumbnails 
of slides printed together on a sheet of paper. 
Speaker notes can be developed for the presenter. 
They are meant to aid the oral presentation and 
are used to support the slides. Handouts and 
speaker notes can be customised to suit specific 
requirements; for example, headers and footers 
can be added.

Create handouts
Earlier, you used the Slide Master to make the style of your slides consistent. You 
are now going to use the Handout Master to add information to your handouts. 
This will then be reproduced on all of the handouts in your presentation. The 
information you add using the Handout Master will only appear on your 
handouts, not on your slides.

Follow these steps.

1. Go to the View tab and select Handout Master. You will see a template
displaying blank outlines of your slides.

2. Within the Handout template area there are four editable regions (on the four
corners of the page). These include:
• Header Area
• Footer Area
• Number Area
• Date Area.

3. Click on the Header Area. The placeholders will be displayed.
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Apply transitions
Slide transitions are the animation-like effects that occur in Slide Show view 
when you move from one slide to the next. You can control the speed of each slide 
transition effect, and you can also add sound. 

PowerPoint includes many different types of slide transitions, including:

• no transition • blinds horizontal
• blinds vertical • box in
• box out • checkerboard across
• checkerboard down • comb horizontal.
• comb vertical

Add the same slide transition to all of the slides in 
your presentation
1. On the Home tab, click a slide thumbnail (you

need to be in Normal View for this to work).

2. On the Transitions tab, in the Transition to
This Slide group, click a slide transition effect.

3. To set the slide transition speed, in the
Timing group, click the arrows next to
Duration, to increase or decrease the speed.

4. In the Timing group, click Apply to All.

Add different slide transitions to the slides in your 
presentation
1. On the Home tab, click a slide thumbnail.

2. On the Transitions tab, in the Transition to This Slide group, click the slide
transition effect that you want for that slide.

3. To set the slide transition speed, in the Timing group, click the arrows next to
Duration, to increase or decrease the speed.

4. To add a different slide transition to another slide in your presentation, repeat
steps 2 through to 4.
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1. On the Slide Show tab, in the Set Up group, click Rehearse Timings.

2. The Rehearsal toolbar appears, and the Slide Time box begins timing the
presentation.

Next Pause Repeat
Total time for 
presentationSlide Time

3. While you time your presentation, do one or more of the following on the
Rehearsal toolbar:
• To move to the next slide, click Next.
• To temporarily stop recording the time, click Pause.
• To restart recording the time after pausing, click Pause.
• To restart recording the time for the current slide, click Repeat.
• After you set the time for the last slide, a message box displays the total

time for the presentation and prompts you to do one of the following:
−− To keep the recorded slide timings, click Yes.
−− To discard the recorded slide timings, click No.

• Slide Sorter view appears and displays the time of each slide in your
presentation.

If you do not want the slides in your presentation to advance automatically by 
using the slide timings that you recorded, do the following to turn the slide 
timings off:

• On the Slide Show tab, in the Set Up group, clear the Use Timings
check box.

• Note: To turn the slide timings on again, select the Use Timings check box.

Music, sound and video
To make a multimedia presentation you can add 
music, sound or video. These are added from files 
on your computer. You will need speakers and a 
sound card to be able to play sound and music in 
your presentation. 
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Whatever your work task, you will always have to work within a designated time 
line. This means having the work ready by a specified time. You may have to 
prepare a presentation for a client or meet a deadline, such as a conference. 

Always find out when the presentation is required and enter this date in your 
diary. Clarify and plan the task to work out how long it is likely to take. Careful 
planning means there will be no last-minute panic. If you are developing an 
electronic presentation for someone else, always ask when a draft of the material 
is required. The presenter will generally want to rehearse the material and may 
suggest further amendments or adjustments.

Example: checklist for planning work tasks
A checklist can sometimes help you plan a work task. Preparing presentations will become 
less problematic once you are familiar with the requirements of your organisation. The 
following table is an example of a useful planning checklist.

Task Deadline Requirements Completed

Prepare an 
electronic 
presentation 
for Kyle for the 
board meeting.

Tuesday 
10 May

As outlined in draft.
Company logo on all slides.
Use company colours in headings.
Use Arial bold for headings and 
Times New Roman for text.
Draft ready by 7 May for rehearsal.
Print handouts and speaker notes.

2E	 Work to a time line
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This learning checkpoint allows you to review your skills and knowledge in 
creating presentations.

Part A
Read the case study. Write down your answers to the questions.

Case study

Claire was told to prepare an electronic presentation to show to external clients. She 
knew that the clients wanted information about new legislation and how it was affecting 
the organisation. She found lots of legislative documents and used the fine details to fill 
the slides that made up the presentation.
Claire then produced speaker notes that contained additional, detailed information. 
When Claire delivered her presentation, the audience seemed confused and some 
clients appeared to fall asleep. She later found out the audience wanted a general 
outline of the legislation and the details she presented to them on the slides and in her 
notes were too complicated.

1. Describe what Claire should have done before producing the presentation.

2. What were the consequences of Claire’s poor planning?

Learning checkpoint 2 
Create presentations
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There are many websites that have information about Microsoft Office 
applications. These usually contain frequently asked questions (FAQs) and give 
solutions to common problems. You can also download updates, tools and any 
fixes that Microsoft has developed for its software problems.

You may find the following websites useful.

www.support.microsoft.com 

This is Microsoft’s main site for finding help with Microsoft products. You can ask 
questions online and download files, including service packs, drivers and patches. 
You can also access the Microsoft Knowledge Base.

www.office.microsoft.com 

This site provides resources for all Office applications. It has news, announcements 
and useful files for you to download. You can open this site by choosing Help, 
Office on the Web in all Office applications.

Use training booklets
There are many ways to learn about computer 
functions and software packages. You can go to 
a training course to learn a particular computer 
function. Some suppliers also provide instructions 
on how to use their equipment.

You may have received some training when you 
started your job, but it should not stop there. It 
is important to keep up-to-date with technology. 
Try to locate the courses in your area that offer 
software training. These courses usually provide 
a comprehensive set of instructions or notes that are worth keeping for future 
reference.

Software help tips
Other sources of help for solving problems with word processing software include:
• accessing paper-based manuals and training booklets in your workplace
• finding websites that offer advice on software use
• asking colleagues for help and advice
• accessing training courses in your area.
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Change how PowerPoint corrects and formats 
your text
To automatically turn spelling and grammar check on or off:

1. Click the Microsoft File tab and then click Options.

2. Click Proofing.

3. Under When correcting spelling in PowerPoint, select or clear the Hide
spelling and grammar errors check box, and then click OK.

Note: If you want to select the Hide spelling and grammar errors check box, you 
must also select the Check spelling as you type check box.

Add an entry to the list of automatic corrections
To add an entry to the list of 
automatic corrections:

1. Click the File Tab and then click
Options.

2. Click Proofing.

3. Under AutoCorrect options, click
AutoCorrect Options, and then
click the AutoCorrect tab.

4. In the Replace box, type a word
or phrase that you often mistype
or misspell. For example, type
usualy.



 © Aspire Training & Consulting 83

Topic 3
Finalise presentations

How you store your presentation depends on the requirements of your 
organisation and who needs to access to the presentation. If your presentation 
needs to be available to all your colleagues, you would store it in an appropriate 
place on the organisation’s server. Your colleagues can then access the presentation 
from their workstation if they have PowerPoint installed on their computers.

An important task when creating and editing presentations is saving your work. 
Saving the presentation ensures that you can edit 
or print it again when required. Each organisation 
has its own policies regarding the naming and 
storing of electronic documents and it is important 
that you follow these procedures so that you and 
other staff can access the documents as required.

Most presentations you create will be stored 
electronically and occasionally hard copies 
(printouts) of the presentations may be stored in 
the organisation’s paper-based filing system.

Electronic file storage
Each presentation needs to be easily identifiable. Your organisation is likely to have 
an established system for naming electronic files to ensure all employees are able 
to find files when required.

Folder structures and naming standards
Folders are used to organise files so they are easier to locate. Each organisation 
uses folder structures and naming standards to ensure that all files are stored in 
the correct location. If your organisation has a network, you may have shared 
directories and folders that several staff may have access to. The advantages of 
using shared directories and naming standards include the following.

Advantages of shared directories and naming standards

Organised files are easy to find. For example, it is much easier to find one 
file in 20 than it is to find one in 100.

If an employee is away, other employees can check to see how much of a 
document the employee has completed and finish it if necessary.

continued …

3D	 Store your presentation


